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Introduction
This tutorial explains the roles of the Vsystem components and how they provide the necessary tools for creating control
display windows and real-time databases. You will walk through creating a simple Vsystem database with a standard text
editor. You will also learn how to use Vdraw to create a simple control display window and how to link this window to the
Vsystem database. In addition, you will learn to use the Valarm alarm monitoring program and the Vscript scripting facility.

Note To obtain the correct results as you perform the exercises in this tutorial, you must proceed through the
instructions in a linear fashion; each chapter builds on the processes you performed in the previous chapters

 This chapter discusses the roles of the Vsystem components, provides the background for the example database used
throughout the manual, and introduces the remaining chapters.

Note Please keep in mind that the systems you will be setting up in your work place will be much more
complex than what you do in this tutorial. Vsystem has a number of utilities and graphical interfaces to make
your setups easy; these utilities are explained in detail in the Vsystem User's Guides

 

The Vsystem Components
This section describes the role of each Vsystem component in assisting you to create and monitor a control system.
Vsystem combines an extensive yet easy-to-use graphics package with a networked, open, real-time database. You can
easily create control display windows and link them to the Vsystem real-time database without programming. And you can
modify these control display windows to fit the changing needs of a project.

At the heart of Vsystem lies Vaccess, a user-extensible, real-time database and library of access routines. The application
database, which provides hardware links, can be organized as one database or as separate databases installed on different
computers (nodes) in a network. Vaccess transparently supports the individual components, defined below, that make up
Vsystem.

•  Vdraw: A graphically oriented toolbox used to create and run control displays.

•  Valarm: An alarm display program that monitors alarms within the database.

•  Vlogger: An archiving program that acquires data from the Vsystem database and archives it to standard output
devices.

•  Vscan: An active connection between the input hardware and the Vsystem database.

•  Vscript: A scripting facility non-programmers can use to write scripts that interact with the Vsystem database.

While the Vsystem components communicate with one another through Vaccess, their modular design permits greater
flexibility as you design and develop each project.  Figure 1 shows the Vsystem architecture and the relationship of the
components to Vaccess.

Figure1 - Vsystem architecture
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Vsystem Real-Time Databases

Conversion Routines and Handlers

Facility I/O

Creating a Simple Control System with Vsystem
This tutorial instructs you in using Vaccess to create a simple Vsystem database to monitor and control the functions of a
furnace. You will use Vdraw to create a furnace control display window and then activate it, as shown in Figure 2, by linking
it to the database.

You will also learn how to link the alarm manager to the database and how to write a script within the Vscript environment
to control the database.

Figure2 - Active Vdraw control display window
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Each chapter listed below instructs you in how to use a particular Vsystem component to create the overall furnace
application.

•  Chapter 2 : You will create an ASCII file that defines and generates the Vsystem database.

•  Chapter 3 : You will create and activate the control display window shown in the illustration above.

•  Chapter 4 : You will edit a database channel with the Db_view utility.

•  Chapter 5 : You will monitor alarms and warnings for a channel with Valarm.

•  Chapter 6 : Using Vscript, you will write a script that controls the active furnace display.

•  Chapter 7 : You will create an archive file with Vlogger and view the archived data with Vtrend.
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Creating a Vsystem Database
This chapter discusses the roles played by Vgen, the database-generating utility, and channels in creating a Vsystem
database. After learning the concept of "channels," you will create channels for the furnace application from an ASCII file,
using Vsystem keywords. You will then use Vsystem commands to convert the ASCII file to an intermediate database file
that you can map into memory with the Db_map utility.

Creating a Database With a Standard Text Editor
No conventional programming is required to define a Vsystem database. Instead, you use a standard text editor to create
ASCII files. These text files use a keyword syntax and can contain nested files and macro definitions. Once you create an
ASCII file, you run Vgen to read the text file and create an intermediate database file. Finally, you use the db_map utility to
map the intermediate file into memory.

When creating an ASCII file, you define channels to be used by this application. Channels are the fundamental structural
units of the Vsystem database. Channels can be considered the communication path between Vaccess and a particular
hardware device or other software.

Various types of hardware require different channels. For example, a simple binary switch uses a channel that carries only
one bit of information ("on" or "off"), while a device controlling voltage requires a "real" channel. Vsystem fully supports
the following channel data types.

BINARY A two-state channel.
DOUBLE A double-precision floating-point number, single value, or array.
INTEGER A channel holding 32-bit integer values, a single value, or an array.

UINTEGER A channel holding 32-bit unsigned integer values, a single value, or an array.
INT16 A channel holding 16-bit signed integer values, a single value, or an array.

UINT16 A channel holding 16-bit unsigned integer values, a single value, or an array.

INT8 A channel holding 8-bit signed integer values, a single value, or an array.

UINT8 A channel holding 8-bit unsigned integer values, a single value, or an array.

REAL A single-precision floating-point number, single value, or array.

STRING A channel holding character string information, a single value, or an array.

TIME A channel storing time information.

Channels can also be considered virtual representations of physical input/output points of an I/O system made up of such
things as sensors, actuators, servos, and thermocouples. The channel types listed above define the characteristics of these
I/O points.

Defining the Furnace Application
This tutorial shows you how to define a furnace application for two rooms, each with a simple open or shut damper. Each
room has a thermostat for setting room temperature and a temperature channel for displaying the temperature of the
room. You will also define a channel that turns the furnace off and on and a channel that shows the availability status of
the furnace.

The furnace database will consist of five output channels:

•  A furnace control channel that turns the furnace on and off.

•  A damper channel that opens and closes a damper for Room 1.
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•  A damper channel that opens and closes a damper for Room 2.

•  A thermostat channel that controls the thermostat for Room 1.

•  A thermostat channel that controls the thermostat for Room 2.

The furnace database will also consist of four input channels:

•  A furnace status channel that indicates whether the furnace is available.

•  A temperature channel that displays the temperature of Room 1.

•  A temperature channel that displays the temperature of Room 2.

•  A temperature channel that displays the temperature of the furnace.

Assigning Channels to the Furnace Application
In the text editor of your choice, create a file named furnace.adb.

In the following example, note that the first line of the definition for each channel begins with a dollar ($) character,
followed by the channel name. Vsystem references each channel by a unique name. When you define channel names, keep
the following in mind:

•  A channel name can be a string of up to 512 characters in length.

•  The dollar ($) character indicates the beginning of the definition of a channel.

The second line of a channel definition declares the data type for the channel. The subsequent lines of the definition
vary, depending on the data type declared. Vgen keywords, documented in your Vsystem Vaccess Reference Guide, are
underlined here for emphasis.

Creating Binary Channels

The first set of channels you enter defines the binary channels for the database. First, use the binary keyword to
declare the channel a binary channel. You will specify the values for the binary zero (b0) and binary one (b1) states.
The values for these keywords should be enclosed in double quotation marks (" ").

The value keyword supplies the initial value for the binary channel. The out keyword identifies the channel as
an output channel associated with control hardware. The in keyword identifies the channel as an input channel
associated with readback hardware.

$furnace_control

binary

b0 "Off"

b1 "On"

value Off

out

 
$furnace_status

binary

b0 "Unavailable"

b1 "Available"

value Unavailable

in
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$room_1_damper

binary

b0 "Closed"

b1 "Open"

value Open

out

 
$room_2_damper

binary

b0 "Closed"

b1 "Open"

value Open

out

Creating Integer Channels

The next set of channels you enter defines the integer channels for this database. First, use the integer keyword
to declare the channel an integer channel. The units keyword enables you to specify the units associated with the
external value of the channel. The label keyword adds descriptive information to the channel. The out keyword
identifies the channel as an output channel associated with control hardware.

$room_1_thermostat

integer

units "degrees"

label "thermostat setting room 1"

out

 
$room_2_thermostat

integer

units "degrees"

label "thermostat setting room 2"

out

Creating Real Channels

The final set of channels you enter defines the real channels for this database. First, use the real keyword to declare
the channel a real channel. The units keyword enables you to specify the units associated with the external value of
the channel. The label keyword adds descriptive information to the channel. The in keyword identifies the channel
as an input channel associated with readback hardware.

$room_1_temp

real

units "degrees"

label "temperature setting room 1"

in

 
$room_2_temp
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real

units "degrees"

label "temperature setting room 2"

in

 
$furnace_temp

real

units "degrees"

label "furnace temperature"

in

Channel definition for the furnace application is now complete. Save the file as furnace.adb and then exit the text
editor.

You can find a copy of the furnace.adb file in the Vsystem examples database subdirectory.

Generating the Vsystem Database
To create a Vsystem database, you will first use the Vsystem vgen command to convert the ASCII database file (with
extension .adb) to an intermediate database file (with extension .idb). Then, you will use the db_map utility to map the
generated intermediate file into memory for later access.

Generating the Intermediate Database File

To convert an ASCII database file to an intermediate database file

•  At the system prompt, enter:

vgen furnace.adb furnace.idb

If your command is successful, this message appears:

Output file = furnace.idb

 

[Processed 9 channels]

[Successful completion]

Mapping the Intermediate Database File

Once you have generated the intermediate database file, use the Db_map utility to map this file into memory.

To map the intermediate database file

•  At the system prompt, enter:

db_map furnace.idb tutor

Here, tutor is the database name that precedes a channel name in a channel specification, such as
tutor::room_1_temp. The mapped database tutor resides in the Vsystem hostname db subdirectory. For
example, if the hostname of your machine is Computer1, you will find the mapped database tutor in the Vsystem
computer1 db subdirectory.
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Note For any application that refers to a channel in a database, precede the channel name (for example,
room_1_temp) with the database name (for example, tutor), followed by two colons (::), as shown in
the paragraph above.

  WIN    In Windows, the mapped database tutor resides in the %vsys_root%\hostname\db directory .
For example, if the hostname of your machine is Computer1, you will find the mapped database tutor in the
%vsys_root%\computer1\db directory.

 LINUX   In Linux, the mapped database tutor resides in the /vsys/hostname/db directory.

  VMS    In VMS, the mapped database tutor resides in the vsys_root:[hostname.db] directory.

Accessing the Database With Other Vsystem Utilities
You can now access this database from within Vsystem by using one of the Vsystem utilities. One such utility is db_access,
which you can use to verify the existence of channels in the tutor database.

To run the db_access utility

At the system prompt, enter:

db_access

At the prompt (->), enter the database name, followed by double colons (::) and the name of the channel you want to
access, in this case room_1_thermostat, as shown below.

Enter channel name ( . to quit )

<channel name> [optional value to be written]

->tutor::room_1_thermostat

The following message appears, containing all of the information available for this channel:

Channel Name: ROOM_1_THERMOSTAT

Local Channel Index: 5

Label: thermostat setting room 1

Upper Equipment Limit: DEFAULTED

Lower Equipment Limit: DEFAULTED

Upper Display Limit: 0

Lower Display Limit: 0

Slope: 0.000000

Offset: 0.000000

Units: degrees

Delta: 0

Size: 1

Element Decimal Hex

[0] 0 0

---------------------------------

Enter channel name ( . to quit )

<channel name> [optional value to be written]

->
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At the prompt (->), enter a period (.) to quit, as shown below:

->.

The following message appears:

exiting...

Note Because you did not define equipment limits for the channel when it was created, Vgen inserted default
maximum and minimum values for the defined channel type, as noted by the text DEFAULTED.
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Running Vdraw
This chapter instructs you in how to use Vdraw to create a control display window for the furnace application and connect
it to the Vsystem database. You will also learn how to create control tools, which dynamically connect control display
windows to the database.

Getting Ready to Start Vdraw

Verifying the Database

Use the Db_access utility to verify your database definition. Enter the following command:

db_access tutor::*

and make sure that your list of channels and values is displayed.

Terms You Need to Know

This section prepares you for using Vdraw with instructions on basic window and mouse terms.

Window Terms

This tutorial uses the terms "drawing windows" and "active windows" when describing Vdraw operations.
Drawing windows (also called "inactive") are windows in which you graphically create and modify control
display windows.

Active windows are drawing windows that link to the real-time database and display the "live" data in the
system. You can monitor and control this data through these active control display windows.

Graphics and text placed in control display windows are referred to as "objects."

Mouse Terms

You can operate the mouse buttons in the following ways:

•  Click means to press and release the mouse button, producing a "click" sound. Unless otherwise indicated,
you click the mouse button only once for each clicking procedure, as opposed to double-click.

•  Select means to click the mouse button while the mouse pointer is positioned on a referenced object.

•  Drag refers to the act of pressing a mouse button while at the same time moving the mouse in a desired
direction until the selected object you are moving, or the selection rectangle, is where you want it.

•  Double-click means to click the mouse button twice quickly without moving the mouse.

•  Press means to use the mouse button to push down (click on) a button in an active control display or to use
your finger to push down a keyboard key.

Left Mouse Button

Use the left mouse button to select drawing tools from the Vdraw Toolbox and to control drawing and editing
objects in the drawing windows. Select the  Pointer tool in the Toolbox, use the mouse to move the Pointer tool
to an object, and then click the left mouse button to select the object for editing. Click the left mouse button
once again to deselect the object.
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You can also press the left mouse button and drag the mouse pointer around objects, creating a selection
rectangle within whose boundaries all objects are selected. Additionally, you can select a drawing tool or
control tool in the Toolbox, then click and drag the mouse to draw a corresponding object.

For this tutorial, when you are instructed to press or click a mouse button, the left mouse button is assumed
unless otherwise specified.

Tip  If you have the Pointer tool selected, you can press the CTRL key and the left mouse button
together to continue selecting additional drawing objects in the control display window. The
boundaries of the selection rectangle extend to include the additional objects selected.

 

Middle Mouse Button (Optional)

Regardless of which tool is selected in the Vdraw Toolbox, you can click the middle mouse button to select
objects for editing, and then continue to add additional objects for editing. With the middle mouse button
pressed, you can also drag the mouse pointer around any objects you want to add to the selected object.
The boundaries of the selection rectangle extend to include the additional objects. You can select as many
additional objects as you want to include in the edit.

Right Mouse Button

To display a pop-up menu, place the mouse pointer within a control display window and click the right mouse
button. If you have an object selected when you click the right mouse button, the pop-up editing menu for
that object appears. If you have no object selected in the control display window, the right mouse button click
displays the pop-up drawing mode menu (if the control display window is inactive) or the active mode menu (if
the control display window is active).

Creating the Furnace Control Display Window
You can start Vdraw from the command line by entering the following command at the system prompt:

vdraw

or by double-clicking on the Vdraw icon.

After you start Vdraw, the Vdraw Toolbox appears, as shown in Figure 3.

Figure3 - Vdraw Toolbox
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Pointer Tool

For selecting objects in drawing windows. You must use the Pointer tool whenever you are instructed to
select an object in a drawing window.

Properties Tool

 
For specifying characteristics such as line weight, fill color, and font style

Drawing Tools

For drawing the control display window graphics.

Control Tools

For adding control objects that dynamically connect the control display window to a database.
 

Creating the Drawing Window

To open a new drawing window (shown in Figure 4), click the New Control Display
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button in the Vdraw Toolbox or select New on the File menu in the menu bar. You will start drawing objects and
creating control tools in this drawing window.

Figure4 - New drawing window

Placing a Grid in the Drawing Window

A grid in the drawing window helps you align the objects you create.  To add a grid to the drawing window select

 on the toolbar

The grid size can be changed in the Window Properties dialog.  Select the Window menu and then select Properties...
Figure5 - Window Properties
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The Window Properties dialog appears as shown in Figure 5

Figure6 - Windows Properties Attributes

In the Window Properties dialog, select the Attributes tab.  In the Grid Size field, enter a value, in pixels, to specify the
density of the grid. Here, enter 12.

1. To display a grid in the drawing window, check the Show Grid Dots checkbox .

2. To activate the grid so that objects snap to the grid points as you create them, check the Snap to Grid checkbox.

3. If you want the control display window to have a specific title when the window is activated, enter the title in the
Active Title field. Here, enter Furnace Control Display.

4. Click OK to execute the options you selected. The grid should now appear in the drawing window.
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Creating the Furnace Object

To begin drawing in the Furnace Control Display window, click the Rectangle drawing  tool button in the Vdraw
Toolbox.

To create the furnace object

Position the mouse pointer in the drawing window where you want to begin drawing the furnace object.

1. Press and drag the mouse pointer diagonally to create a rectangle.

2. When the furnace object is the size you want, release the mouse button.

Figure7 - Example of a furnace object and grid

Furnace Object
 
Grid
To edit an object, in the Vdraw Toolbox, click the Pointer tool.

Using the Pointer tool, click in the object you want to edit to select it.

Place the Pointer tool within the object and click the right mouse button to display the pop-up editing menu for that
object.

On the editing menu, select an option and edit the selected object.

Labeling the Furnace Object

To label the furnace object, click the Text drawing tool button  in the Vdraw Toolbox.
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Place the mouse pointer where you want the text to begin (here, place the mouse pointer within the furnace object)
and click the mouse button to display the text entry box.

Figure8 - Text entry box

Begin typing to enter text. Here, enter Furnace to create the label "Furnace" within the furnace object. If you do not
like the starting location for the text, select Cancel and try again.

To correct a typing error, press the BACK SPACE or DELETE key and retype the text.

Click OK . The drawing window should appear as shown in Figure 9.

Figure9 - Furnace object with label

 

To change the appearance of text
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In the Vdraw Toolbox, click the Pointer tool.

1. Using the Pointer tool, select the text you want to modify. The selection rectangle surrounds the text.

2. Then click the Properties button  in the Vdraw Toolbox or on the Object menu in the menu bar, select
Properties.

Figure10 - Text properties

The Graphic Properties dialog appears (showing the Text tab), as shown in Figure 10. In the Graphic Properties dialog,
you can modify such attributes of the text as font, color, and size.

Creating the Ducts

To create the ducts connecting the furnace to the two rooms, as shown in Figure 11, click the Constrained Line 
drawing tool button in the Vdraw Toolbox. With this drawing tool, you can draw three styles of straight lines: slanted,
vertical, and horizontal.

To create the furnace ducts

Position the mouse pointer where you want the line to begin.

1. Drag the mouse pointer until the line is the appropriate length.

If you move the mouse in a circular motion while continuing to press the mouse button, the line rotates at 45-degree
angles relative to its starting position.

1. When the line is the desired length and angle, release the mouse button.

2. Continue using the Constrained Line drawing tool to draw the rest of the duct lines. The furnace control display
window should appear as shown in Figure 11.
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Note To delete a line, select the line (using the Pointer tool) and press either the DELETE key or the
BACK SPACE key, depending on the configuration of your keyboard.

Figure11 - Furnace ducts

Saving the Drawing Window

Vdraw provides a way to periodically save a drawing window while you are creating it.

To save a drawing window

In the Vdraw Toolbox, click the Save button. 

-or-

On the File menu in the menu bar, select Save .

1. In the File name field of the Save As window, enter the filename furnace_tutor, then select the directory in
which you want to save the control display file.

2. Click Save to save the file.

From now on, each time you save this file, the filename automatically displays in the File name field. We encourage
you to save your files frequently.

Note It is not necessary to specify a file extension; Vdraw gives the file the appropriate file
extension, .vcd, for Vsystem control display.

Adding Control Tools to the Application

You use the control tool buttons in the Vdraw Toolbox to create control tools. Control tools dynamically connect to
the Vsystem database and enable you to monitor and control equipment from any workstation on the network.
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For this tutorial, the first control tool you will place in the drawing window is a button that turns the furnace on and
off. Buttons are binary control devices, so they are appropriate for situations in which an object needs to toggle
between "on" and "off."

Creating Button Control Tools

To create a button control tool, select the Button control tool .

In the drawing window below the furnace object, hold the mouse button and drag the mouse pointer to draw a box
the size you want the activated Button control tool to be, as shown below

When you release the mouse button, the Button Control Tool Properties dialog appears. A control tool dialog
provides a form for specifying all of the information necessary to configure the control tool.
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Once you have created a Button control tool in the drawing window, you can use the editing tools to create
additional buttons.

For this tutorial, specify the following options in the Button Control Tool Properties dialog:

Control Channel Name

Control channels are output channels that attach to and control the hardware. On the Channel tab, in the
Control Channel Name field, enter the name of the control channel to which you want to connect the Button
control tool, in this case, tutor::furnace_control.

Note You must specify the database name (tutor) , followed by double colons (::), before the
name of a channel (furnace_control) in a specified database.

You can also use the Choose button to specify the control channel. Click the Choose button above the Control
Channel Name field. In the Database field of the Channel Selector window, enter the name of the database you
created for the furnace application, tutor , and press ENTER on the keyboard. The tutor database name displays
in the list box, along with all of the channels you defined in the tutor database, as shown in Figure 12

Figure12 - Channel Selector window, showing database channels
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Select the furnace_control channel; the channel name becomes highlighted. Then click OK to apply your
selection to the Button Control Tool Properties dialog. The selected tutor::furnace_control channel name now
displays in the Control Channel Name field, as shown in Figure 13

Figure13 - Channel name displayed in Button Control Tool Properties dialog
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Button Type

A toggle button switches a channel between its two binary states, while a push button places the channel into
a true (B1) state as long as the mouse button is depressed. When you release the mouse button, the channel is
set to a false (B0) state.

Select the Options tab in the Button Control Tool Properties dialog as shown in Figure 14 and specify the
button type for your Button control tool by selecting Toggle from the Button Type drop-down list.

To create a three-dimensional button that more clearly shows its pushed (on) and nonpushed (off) state, click
the Three-D Appearance checkbox.

Figure14 - Button Control Tool Properties Options tab
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Click OK to apply your selection to the new Button control tool. The box you drew in the drawing window is
now labeled "Button" in the window. To modify the text of the button label, select the Attributes tab in the
Button Control Tool Properties dialog.

Labeling Button Control Tools

After you have created the first Button control tool, use the Text drawing tool button in the Vdraw Toolbox to
create the label "Furnace Control."

In the Vdraw Toolbox, click the Text drawing tool .

1. Place the mouse pointer where you want the text to begin, below the Button control tool, and click
the mouse button to display the text entry box.

2. In the text entry box, enter Furnace Control .

3. Click OK .

The drawing window should appear as shown in Figure 15

Figure15 - Labeled Button control tool

 

To modify the text in the label

Select the label with the Pointer tool.

1. In the Vdraw Toolbox, click the Properties button.

-or-
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On the Object menu in the menu bar, select Properties.

-or-

On the pop-up editing menu, select Properties.

1. In the Graphic Properties dialog, make your text modifications. 

 

Note Once you have created a control tool, you can use the editing options to resize or reposition
it, as described in the next section.

Creating Additional Button Control Tools Using the Editing Options

You can use the Button control tool you just created to create additional Button control tools. By using one button to
create another, you save time and maintain size consistency.

To copy the Furnace Control Button control tool

Using the Pointer tool, select the Button control tool you just created.

1.  The editing rectangle frames the object, as shown in Figure 16

2.  Click the right mouse button to display the pop-up editing menu.

3.  On the menu, select Copy. The copy of the control tool will not activate (appear) until you either move it or
paste it, as described in step 4.

4.  To reposition the new Button control tool, do one of the following:

•  With the mouse pointer on the middle right handle of the editing rectangle surrounding the Button control
tool, press and drag the mouse pointer to the desired location for the control tool, then release the mouse
button. (See Figure 14 for an illustration of the editing handles on the editing rectangle.)

-or-
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•  Deselect the control tool by placing the mouse pointer outside of the editing rectangle and clicking the
mouse button; then select Paste from the pop-up editing menu.

Figure16 - Editing rectangle and handles

A new Button control tool appears at the selected location. Figure 17 shows the drawing window with the
original Button control tool duplicated.

Now you will assign a different channel to the newly created Button control tool. The editing rectangle should
still be framing the new Button control tool; if it is not, click the Pointer tool in the Vdraw Toolbox and then
select the Button control tool in the drawing window to produce the editing rectangle.

Figure17 - Button control tool duplicated

To assign a channel to the new Button control tool

1.  In the Vdraw Toolbox, click the Properties button.

                -or-

    On the Object menu in the menu bar, select Properties.

2.  In the Control Channel Name field of the Button Control Tool Properties dialog, change the channel name
to tutor::furnace_status . You can also use Choose to select this channel from the channel list in the specified
database.

3.  Click OK to complete the modification.
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4.  The drawing window should now contain two Button control tools below the furnace object.

Next, you will add the label "Furnace Status" to the second Button control tool.

To label the second Button control tool

1.  Following the instructions above for copying the Button control tool, copy the label of the first Button control
tool to a position beneath the second Button control tool.

2.  With the duplicated label still selected, in the Vdraw Toolbox, click the Properties button or on the Object
menu in the menu bar, select Properties .

3.  In the Graphic Properties dialog that appears, in the Text field, change the text of the label to Furnace
Status, then select OK.

Figure18 - Drawing window with two Button control tools

The control tools that control the dampers for Room 1 and Room 2 are also buttons. These two Button control
tools are located to the right of the furnace object. The Button control tool closest to the furnace controls Room
1.

To create the two Button control tools that control the dampers

1.  Use the editing options to copy an existing Button control tool and move it to the base of the left duct.

2.   With the new Button control tool still selected, click the Properties button in the Vdraw Toolbox.

       -or-

     On the Object menu in the menu bar, select Properties.

3.   In the Control Channel Name field of the Button Control Tool Properties dialog, change the control channel to
tutor::room_1_damper; or, use Choose to select this channel from the channel list.
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4.  Add the label Room 1 Damper to the Button control tool by copying and changing the label of the Furnace
Control button.

5.  Copy the Room 1 Damper Button control tool and move it to the base of the right duct.

6.  Repeat step 2 above.

7.  In the Control Channel Name field, change the control channel to tutor::room_2_damper; or, use Choose to
select this channel from the channel list.

8.  Add the label Room 2 Damper to the Button control tool by copying and changing the label of the Room 1
Damper button.

The furnace drawing window now displays all of the Button control tools defined, as shown below.

Figure19 - Completed Button control tools

 To save the drawing window

•  In the Vdraw Toolbox, click the Save button.

-or-

•  On the File menu in the menu bar, select Save.

Adding Meter Control Tools to the Application

Meters and dials are control and monitoring devices for double-precision floating-point, integer, and real channel
types.

 To create a Meter control tool
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1. 
 
Click the Meter control tool button  in the Vdraw Toolbox and move the mouse pointer to the drawing
window.

2.  Drag a box the size you want the meter to be, as shown.

Note The size of the meter box determines the appearance of the activated meter; the software
tries to make a best-fit based on the parameters of the meter. For example, if you create a box that
is too large, the meter will appear off-center within the box when activated. If you are not happy
with the appearance of the activated meter, resize the meter box until it has the look you desire.

When you release the mouse button, the Meter Control Tool Properties dialog appears, as shown below.

Figure20 - Meter Control Tool Properties dialog
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As you can see in the dialog, there are numerous options from which to choose when you define a Meter
control tool; however, for this tutorial, you will create a simple style of meter. The first meter you will create
serves as a temperature gauge for Room 1.

For this tutorial, specify the following options in the Meter Control Tool Properties dialog:

Label
On the Bank tab in the Meter Control Tool Properties dialog, select the Meter tab in the middle of the
dialog. In the Label field, enter the label Room 1 Temperature for the active Meter control tool.
This label displays directly below the Meter control tool when the meter is activated.

No. of Needles
Number of Needles, Keep the default of 1 in the No. of Needles field.
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Channel tab
Select the Channel subtab at the lower part of the dialog.

Channel Name
In the Channel Name field, enter the database channel name to which you want to connect the meter
needle, in this case tutor::room_1_temp . You can also use the Choose button to select a channel from
the channel list.

Changing the Needle Color and Style

Figure21 - Meter Control Tool Properties lower Attributes subtab

Attributes tab
Select the Attributes subtab at the lower part of the dialog
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Needle Color
To change the color of a needle, click the color box next to Needle Color to display the Needle Color
window. In the Needle Color window, Figure 22, click on a color and then click OK .

Figure22 - Needle Color window

Needle Style
To choose a style of needle for the meter, select Open Arrow from the Needle Style drop-down list
box.

Controllable

Set the meter to controllable. When the needle of a meter is controllable, you can change the value of the
Meter control tool by moving the needle on an active control display window with the mouse pointer.
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Options Tab
Select the Options subtab at the lower part of the dialog,4

Controllable
Click the Controllable checkbox .

Display Digital Readout

Enable the Digital Readout
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Readout Tab
Select the Readout subtab at the lower part of the dialog

Display Digital Readout
Click the Display Digital Readout checkbox to display the value below the activated Meter control tool.
  Once this is selected, Readout Label From will be enabled.

Readout Label From
Because this Meter control tool is small and in a limited space, select None from the Readout Label
From drop-down list. The digital readout will display centered, with no label under the Meter control
tool.

Direction
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Attributes Tab
With the Bank tab selected at the top of the Meter Control Tool Properties dialog, select the Attributes
subtab in the middle of the dialog,

Display Alarm Bar
Select Display Alarm Bar to show the alarm limits in the meter

Direction
Select Counterclockwise from the Direction drop-down list, so that the needle of the Meter control
tool moves in a counterclockwise direction.
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No. of Degrees
In the No. of Degrees field, enter 180. The value entered in this field determines the number of
degrees the Meter control tool spans.

Limits

Limits Tab
Select the Limits subtab in the middle of the dialog

Limits
To specify the display limits for the Meter control tool. Select From Form from the Limits drop-down
list.  The Min and Max fields will be enabled.
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Min
Enter 0 in the Min field

Max
Enter 120 in the Max field.

Note The value for the limit that you enter in the Min field overrides the lower display limit value
(if one is defined in the Vsystem database) for the channel to which you connect the Meter control
tool. The value for the limit that you enter in the Max field overrides the upper display limit value
(if one is defined in the Vsystem database) for the channel to which you connect the Meter control
tool.
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No. of Decimal Places for Scales
This option enables you to override the number of decimal places specified with the format keyword
in the Vsystem database. Because this Meter control tool is small and in a limited space, enter 0 in this
field.

Minor Ticks
In the Minor Ticks field, enter a value for the interval between the display of short scaling marks on an
active Meter control tool. For this tutorial, enter 15 in this field. Short tick marks will appear at
15-degree intervals between 0 and 120 degrees.

Major Ticks
In the Major Ticks field, enter a value for the interval between the display of long scaling marks on an
active Meter control tool. For this tutorial, enter 30 in this field. Long tick marks will appear at
30-degree intervals between 0 and 120 degrees.

Labeled Ticks
You can select the interval at which the tick marks for a Meter control tool are labeled with a
numerical representation. Enter 60 in the Labeled Ticks field. Because the upper display value is 120,
numbered tick marks will appear at 0 degrees, 60 degrees, and 120 degrees.

 

Note The more numbered tick marks you assign to a Meter control tool, the more likely it is that the numbers may overlap
each other. The quantity of numbered tick marks present on a Meter control tool depends on the upper and lower display
limits.

Button Label
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Options Tab
Select the Options tab in the Meter Control Tool Properties dialog. In the Button Label field, enter the
label to appear on the Meter control tool when it is deactivated, in this case Meter . Click OK to apply
all of your modifications.

Steps to take after creating a Meter control tool

After you have created the Meter control tool,

1.  click the Text drawing tool in the Vdraw Toolbox to create the label "Room 1 Temperature".

2.  Place the mouse pointer below the Meter control tool where you want the text to begin, and type Room 1
Temperature . Then click OK .

3.  To modify the characteristics of the label text, select the label, then in the Vdraw Toolbox, click the Properties
button.

-or-

On the Object menu in the menu bar, select Properties.
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4.  Make your modifications in the pop-up Graphic Properties dialog.

The following illustration shows the first Meter control tool.

Creating Additional Meter Control Tools

To create additional Meter control tools:

1.  Copy the Meter control tool by selecting it and clicking the right mouse button to display the pop-up editing
menu.

2.  On the menu, select Copy, then move the copy to the right of the original Meter control tool. The new Meter
control tool serves as the thermostat for Room 1.

3.  Select the new meter, then in the Vdraw Toolbox click the Properties button.

-or-

On the Object menu in the menu bar, select Properties .

4.  On the Bank tab in the Meter Control Tool Properties dialog, select the Meter subtab in the middle of the
dialog. In the Label field, change the label to Room 1 Thermostat.

5.  On the lower Channel subtab, in the Channel Name field, change the channel to
tutor::room_1_thermostat, as shown below.
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1.  Click OK on the Meter Control Tool Properties dialog to apply the changes to the new Meter control tool.

2.  Copy the meter label Room 1 Temperature and move it below the Meter control tool for Room 1 Thermostat.

3.  To change the text of the label from "Room 1 Temperature" to "Room 1 Thermostat," select the label for the
second Meter control tool, then perform one of the following actions:

4.  In the Vdraw Toolbox, click the Properties button.

-or-

5.  On the Object menu in the menu bar, select Properties .

6.  In the Graphic Properties dialog that appears, in the Text field, enter the new label text.
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Note Don't forget to periodically save you file.

Adding a Bar Control Tool to the Application

Bars graphically reflect the current value of a double-precision floating-point, integer, or real channel type. Here, we
will create a Bar control tool to control the temperature of Room 1.

In the Vdraw Toolbox, click the Bar control tool button.
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Bar Control
Move the mouse pointer to the drawing window and drag a rectangle the size of the bar you want to
create.

Bar control tool

The Bar Control Tool Properties dialog appears.
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For this tutorial, you will specify the following options in the Bar Control Tool Properties dialog.

Triangle Channel Name
The triangles on Bar control tools serve the same purpose as the needles on Meter control tools. If
specified as "controllable," you can adjust the value of a Bar control tool by moving the triangle back
and forth.
On the Channel tab in the Bar Control Tool Properties dialog, enter the name of the channel to which
the triangle will connect when the Bar control tool is activated. Here, in the Triangle Channel Name
field, enter the channel name tutor::room_1_temp. You can also use the Choose button to select a
channel from the channel list. If you do not enter a channel name, a triangle will not display on the Bar
control tool.
 

Triangle Fill

Attributes Tab
Select the Attributes tab in the Bar Control Tool Properties dialog

Triangle Fill
From the Triangle Fill drop-down list, select Status Color. When this option is selected, the triangle
appears in only one of three color states--green (normal), yellow (warning), or red (alarm)--depending
on which limit has been reached for the assigned channel.

Options
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Options Tab
Select the Options tab in the Bar Control Tool Properties dialog.

Border on Bar
Then click the Border on Bar checkbox . When this option is selected, a one-pixel-width border
outlines the Bar control tool. The color of the border is the same as the line color currently selected in
the Vdraw Toolbox.

Control
From the Control drop-down list, select Triangle, so that you can change the value of a channel by
sliding the triangle on the screen with the mouse. When this option is selected, the channel name
entered in the Triangle Channel Name field becomes the control channel.

Show Alarm Ranges
From the Show Alarm Ranges drop-down list, select Bar to display an alarm bar, which depicts the
alarm and warning regions on the Bar control tool. Normal regions display in the "OK" color, warning
regions display in the warning color, and alarm regions display in the alarm color specified in the
Vdraw definition file.
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Triangle Size
From the Triangle Size drop-down list, select one of the options to specify the size of the triangle
appearing on the Bar control tool (remember: a triangle appears only if a channel name is entered in
the Triangle Channel Name field). The available triangle sizes are Small, Medium, and Large. For this
tutorial, select Medium from the drop-down list.

Scale Tab

Scale Tab
Select the Scale tab in the Bar Control Tool Properties dialog

Show Limits
Click the Show Limits checkbox so that the Bar control tool displays the maximum and minimum limits
specified. When the Bar control tool is activated, the database channel limits display in the font style
specified on the Attributes tab.

Limits
From the Limits drop-down list, select Use Form Limits to override the upper and lower display limits
given in the channel definition. Because this Bar control tool will be connected to the same control
channel as the meter for Room 1, the maximum and minimum display limits should be the same as
those you assigned to the Room 1 meter.  The Min and Max fields will now be enabled.
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Min and Max
Enter 0 in the Min field as the minimum display limit and 120 in the Max field as the maximum display
limit.

Show Tick Marks
Click this checkbox to display tick marks on the scale of the Bar control tool. Because this Bar control
tool will be connected to the same control channel as the meter for Room 1, the units for major (and
minor) tick marks should be the same as those you assigned to the Room 1 meter.

Major and Minor
Enter a value of 15 in the Minor field for the interval between the display of short scaling marks on an
active Bar control tool; short tick marks will appear at 15-unit intervals. Enter a value of 30 in the
Major field for the interval between the display of long scaling marks on an active Bar control tool;
long tick marks will appear at 30-unit intervals.

Scale Type
From the Scale Type drop-down list, select Linear ; the bar will use linear scaling.

Scale Side
From the Scale Side drop-down list, select Top/Left so that the scale and triangle are drawn on the top
of the activated Bar control tool.
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OK
Click OK to apply your modifications.

Steps to take after creating a Bar control tool

In the Vdraw Toolbox, click the Text drawing tool to label the bar Room 1 Temperature.

1. Place the label below the Bar control tool; then click OK .

2. To modify the font of the label, select the label, then in the Vdraw Toolbox, click the Properties button.

-or-

On the Object menu in the menu bar, select Properties .

Creating Additional Bar Control Tools

To Copy the Bar control tool, select it and click the right mouse button to display the pop-up editing menu.

1. Select Copy , then drag the copy below the original Bar control tool.

The new Bar control tool controls the thermostat of Room 1.

1. Select the new Bar control tool, then in the Vdraw Toolbox, click the Properties button.

-or-

On the Object menu in the menu bar, select Properties.

1. In the Triangle Channel Name field (on the Channel tab), change the channel to
tutor::room_1_thermostat . Then click OK to apply the change to the new Bar control tool.

2. Copy the label Room 1 Temperature and move it below the Bar control tool for Room 1 Thermostat.
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3. Change the text of the label from Room 1 Temperature to Room 1 Thermostat:

Select the label of the second Bar control tool.

1. In the Vdraw Toolbox, click the Properties button.

-or-

On the Object menu in the menu bar, select Properties.

1. In the Graphic Properties dialog that appears, in the Text field, change the text of the label to Room 1
Thermostat, then click OK .

 To save the drawing window

•  In the Vdraw Toolbox, click the Save button.

-or-

•  On the File menu in the menu bar, select Save.

The drawing window now appears as shown

 

Note As you can see, the arrangement and size of some of the objects in the drawing window have
changed. This was done to accommodate the information that displays on these objects when the
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window is activated. As you create your own objects, you will probably need to modify their size and
arrangement to make the information display in a useful manner.

Activating the Furnace Control Display Window

Once you create a drawing window, you can easily activate it. When you activate a drawing window, control tools
automatically begin reflecting the current states of the channels to which they are connected. As your system
updates the Vsystem database, the active control display window accurately reflects the changes.

If you defined the control tools as controllable when you created them, you can control the database--and therefore
channel values--from the active control display window by pressing a mouse button, dragging the mouse, or
entering values with the keyboard. If you did not define the control tools as controllable, however, they can only
reflect database states; you cannot use them to change the data.

 To activate a drawing window

• 
 
In the Vdraw Toolbox, click the Activate button.

-or-
•  On the Window menu in the menu bar, select Activate.
-or-
•  Right-click anywhere in the control display window and select Activate Window from the pop-up menu.

The drawing window goes to its active state, as shown in Figure 23.

Figure23 - Active drawing window
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Operating the Bar Control Tools

When a Bar control tool is activated, it reflects the limits assigned with the Limits option, in this case ranging between
the specified limits of 0 and 120. Because you selected Status Color as the color scheme option, the Bar control tool
uses one color to reflect the current status of the channel.

Because you made the triangle of the Bar control tool user-controllable, you can change the value in the database by
moving the triangle.

To move the triangle

•  Place the mouse pointer on the control triangle, press the left mouse button, and drag the mouse right to
increase the channel value or left to decrease the channel value

You can also use the other mouse buttons to move the control triangle. Each mouse button controls a different
increment/decrement rate of a value:

•  Dragging with the left mouse button pressed changes the value at the default movement resolution.

•  Dragging with the middle mouse button pressed changes the value by one-tenth of the movement resolution.

•  Dragging with the right mouse button pressed changes the value by one-hundredth of the movement
resolution.

Figure 23 shows a view of the Room 1 Temperature and Thermostat Bar control tools and their Meter control tools
in the furnace control display window. Notice that each Bar control tool and its corresponding Meter control tool
are set to the same value; this is because you assigned each set of these control tools to the same channel when
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you created them. When you change the value on one of these control tools, the value on the other automatically
updates.

Operating Button Control Tools

The text on each button reflects the current state of the channel assigned to that Button control tool. Because you set
Button Type to Toggle in the Button Control Tool Properties dialog, when you click on the Button control tools, the
channels change to their opposite binary states.

Operating Meter Control Tools

When activated, the Meter control tools display the values that were assigned with the Limits option. The labels
Room 1 Temperature and Room 1 Thermostat also display. Because you selected Display Digital Readout in the
Meter Control Tool Properties dialog, the channel values display along with the units you assigned to them when you
created the Vsystem database.

Because you selected Controllable for the needle on each Meter control tool, you can control the value of the
channel assigned to a Meter control tool by moving its needle or by changing the value directly in the digital readout
box.

To control a Meter control tool by moving its needle

•  Place the mouse pointer on the needle, press the mouse button, and drag the needle to the new value.

The digital readout box reflects the value of the location of the needle on the Meter control tool. The new value is
assigned to the channel as soon as you release the mouse button.

Note When you drag the mouse pointer with the middle or right mouse button pressed, the needle
moves in one-degree increments or decrements. If the Meter control tool is attached to an integer
channel, and if the meter range is small, the needle may not operate as expected when the middle or
right mouse button is used, because the needle can only increment or decrement in whole-number units.

You can also change the channel value directly from the digital readout box.

To change a channel value from the digital readout box

Digital Readout Box
Place the mouse pointer on the Room 1 Temperature digital readout box (see illustration below) and click
the mouse button. A value entry box appears, as shown in Figure 3-44.
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Value Text Box
Using the keyboard, enter the new channel value

OK Button
Then click OK

If you do not enter a new value, the value present when the digital readout box was accessed remains the value of
the control tool.

Showing Control Tools

When the furnace control display window is open, you can view the number of control tools in the control display
window. This can be important, because many control display windows include objects that may appear to be control
tools, but are not.

To view the control tools in a control display window

•  Right-click in the window anywhere there is no tool; on the pop-up menu that appears, select Show control
tools.

-or-

•  On the Tools menu in the menu bar, select Show Control Tools.

A window appears showing the types of control tools and their number at the bottom, as shown below.

Figure24 - Show Control Tools for Inactive Display
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Figure25 - Show Control Tools for Active Display
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You can double-click on a control tool type in either list box (active or inactive) to view all of the control tools for that
type. Subsequent double-clicking on tree items expands each control tool to show the channel(s) it is connected to.

Deactivating a Vdraw Control Display Window

To deactivate the furnace control display window

•  Select Deactivate on the Window menu in the menu bar.

-or-

•  Click the Deactivate button in the Vdraw Toolbox.

This option deactivates all active areas in the control display window and removes all database connections. The
control display window returns to drawing mode.

Closing a Vdraw Control Display Window

You can close a Vdraw control display window from either drawing mode or active mode. The pop-up menu for each
mode contains a Close Window option.

To close a control display window

Right-click anywhere in the control display window.

1. Select Close Window on the pop-up menu that appears..

You can also close a Vdraw control display window by selecting Close on the File menu in the Toolbox menu bar.

If you have unsaved objects in the control display window at the time you choose to close, Vdraw asks you whether
to save them.
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Using the db_view utility
Db_view is a Vsystem utility that provides a graphical view of all the fields within a database channel. You can also use
db_view to change the values of fields in an active database.

For this tutorial, you will use the db_view utility to set upper and lower warning and alarm limits for the channel
tutor::room_1_thermostat.

Running Db_view
To start db_view, enter the following command at the system prompt:

db_view tutor

After you start db_view, the db_view dialog appears, as shown in Figure 26. Because the tutor database is selected in the
list box, the tabs to the right display information related to this database.

Figure26 - Db_view dialog
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Note You can resize the db_view window to show the full channel names if needed.

Database
The Tutor database is selected

Filter
The filter is set to display all channels

Channels
A list of the channels is display with an icon for the channel type.

Database tabs
Select a Tab to display the various information about the database.

ROOM_1_THERMOSTAT
Select the channel tutor::room_1_thermostat by clicking on the channel name in the list box.

Figure27 - Db_view showing a channel selected
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Alarms Tab
For this tutorial, select the Alarms tab to modify the following fields for the selected channel,
tutor::room_1_thermostat .
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Alarm
Before new warning and alarm limits can appear on a control tool, you must activate alarm monitoring for this
channel by clicking the Alarm checkbox in the upper left of the Alarms tab .
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Alarm Type
Because the room_1_thermostat channel is an integer channel, you must set an alarm type of 1, 2, or 3:
 
Alarm type 1 Enables match alarms; that is, the alarm value exactly matches the channel value.

Alarm type 2 Enables a range of alarms.

Alarm type 3 Supports match alarms and a range of alarms simultaneously.
 
Because you did not define a match alarm, from the drop-down list, select 2:Range Alarms as the alarm type.

Note If the proper value is not entered as an alarm type, no alarms are signalled when the channel
enters an alarm state.

UA/BA (Upper Alarm) Value
To specify the upper alarm value, enter 110.

UW (Upper Warning) Value
To specify the upper warning value, enter 100.

LW (Lower Warning) Value
To specify the lower warning value, enter 20 in the LW Value field.

LA (Lower Alarm) Value
To specify the lower alarm value, enter 10 in the LA Value field.
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Apply

When you have completed these modifications, click the Apply button in the toolbar or select the Apply option
on the Channel menu in the menu bar to update the channel in the database.
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Refresh

If you have not yet selected Apply, you can restore the previous values by clicking the Refresh button in the
toolbar or selecting the Refresh option on the Channel menu in the menu bar. In addition, Refresh can be used
to update the fields in Db_view with any values that have been modified in the database.

To exit the Db_view window, select Exit on the Database menu in the menu bar.

Viewing the New Information in an Active Control Display Window
When you activated the furnace control display window, no alarm areas appeared on the control tools, because none were
defined at that time.

Now that you have defined warning and alarm limits, however, an alarm area appears on an active Bar control tool. To view
the active Bar control tool with modified alarm states, you first need to run Vdraw.

To view an active Bar control tool

At your system prompt, enter the vdraw command.

The Vdraw Toolbox appears.

1.  In the Toolbox, click the Open Control Display button.

2.  In the The Open window.  Double-click on the file you want to open, in this case furnace_tutor.vcd.

3.  The furnace control display window appears in the drawing mode.

4.  With the mouse pointer in any empty area in the drawing window, click the right mouse button to display the drawing
mode pop-up menu.

5.  On the pop-up menu, select Activate Window .

6.  When you release the mouse button, the furnace control display window appears in active mode.

When the Bar control tool for Room 1 Thermostat is activated, the lower and upper warning and alarm limits you defined
with the Db_view utility appear in color below the scale of the Bar control tool, as shown below.

Figure28 - Alarm limits showing for the Room 1 Thermostat
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To complete this chapter, exit Vdraw by selecting Exit on the File menu in the menu bar. You do not need to save the
Vdraw control display window prior to exiting.
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Using Valarm to Monitor Channels
This chapter instructs you in how to use the Valarm graphical interface to monitor alarms in a channel.

Valarm is an application that enables you to monitor alarms on selected channels in your database. First, you will work with
the database by:

•  Adding alarm and warning limits to the room_1_temp channel in the furnace.adb file.
•  Running down the database to apply your modifications.
•  Generating a new .idb intermediate database file.
•  Verifying the database.

Then, you will run Valarm and use the Valarm viewer to monitor alarms and warnings and to edit (add or delete) the
channels you want to monitor. Finally, you will print the alarm data, clear the alarms, and reset Valarm.

The Valarm Components
The three primary components of Valarm are:

Viewer

The Valarm Viewer comprises the Viewer window and the Editor window. You can use the Valarm Viewer window to:

•  View, acknowledge, and print active alarms.
•  Add and remove monitored alarm channels.
•  Enable and disable alarms.

Daemon

The Valarm Daemon archives and prints alarm events as they are entered, acknowledged, and enabled or disabled.
You can find more detailed information on the Daemon in the Vsystem Valarm User's Guide.

Historian

The Valarm Historian reads and displays the alarm history archives. The Historian window displays the history
information of alarm channels and allows you access to the Filters window, where you can set various restrictions
for what history information to review. When opened, the Historian takes a "snapshot" of the alarm archive file as it
appears at that time.

Although the Historian reads the archive files created by the Daemon, you can run the Historian without running the
Daemon. You can find more information on the Historian in the Vsystem Valarm User's Guide.

Running Valarm
You can start Valarm by entering the following command at your system prompt:

valarm -viewer tutor::*

By placing the asterisk (*) after the database name, you are telling Valarm to load all of the channels in the tutor database.

When you start Valarm, the Valarm Viewer window appears. If the current value of the channel does not fall in an alarm or
warning state, the list box of the Valarm Viewer window is empty, as shown below.
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Valarm Viewer window

For each channel listed, the Valarm Viewer window provides the following information:

•  The date the channel went into an alarm or warning state.
•  The time the channel went into an alarm or warning state.
•  The full name of the channel in the alarm or warning state.
•  The state of alarm or warning the channel is in.
•  The channel value that triggered the alarm.
•  The alarm or warning limit defined to signal the alarm.
•  The acknowledgment status of the alarm.

Using the Valarm Viewer

Although Valarm does not require Vdraw to be open to monitor channels, this portion of the tutorial requires the
presence of both. At your system prompt, enter the following command to open the active Furnace Control Display
window.

vdraw /active furnace_tutor

Figure29 - Furnace Control Display window showing alarm state
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The furnace control display window opens in active mode. If the room_1_thermostat channel is in an alarm state, as is
the channel assigned to the upper Bar control tool in Figure 29, the alarm states appear in the Valarm Viewer window
and the alarm sounds.

Note If the Room 1 Thermostat Bar control tool is not in an alarm state, click in the digital field at the
bottom of the Room 1 Thermostat Meter control tool and change the number there to 5.0.

Figure30 - Valarm Viewer window showing alarm
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 Unless you have used the alarmColorIndex, warningColorIndex, and okColorIndex resources to define unique state
colors, the alarm, warning, and cleared channel colors are:

•  Red for all alarm states.

•  Yellow for all warning states.

•  Green when either alarms or warnings are cleared.

Shadings are used in place of color for monochrome monitors.

Sound

In the toolbar, you can toggle the button to turn on or off the sound.  Or on the Options menu, select
Sound.
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Ack (Acknowledge Alarms)

To acknowledge the alarm state of a channel, select the alarm you want to acknowledge in the Valarm Viewer
window. Then either select Acknowledge on the Alarm menu in the menu bar or click the Ack button in the toolbar.
Once you have acknowledged an alarm, an "X"
appears in the Ack column of that alarm.

Note You can also click the right mouse button on the listed alarms and select Acknowledge on the pop-
up menu.

Editor

You can use the Editor window to specify which alarm channels to monitor. Or select Editor in the Alarm
menu.

Figure31 - Editor window showing tutor database information
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You can use the Editor window to add and delete alarm channels in the list of monitored channels, as well as to
enable and disable alarms. The Full Channel Name column in the Editor window lists the names of all the channels in
the tutor database currently monitored by the Valarm viewer. If more than 10 channels are listed, a vertical scroll bar
appears on the right.

Clearing the Alarms

If you have not yet acknowledged the alarm and warning messages, do so now. Before the alarm and warning
messages can be cleared from the Valarm Viewer window, you need to return the channel to a normal (unalarmed)
state.

To return the channel tutor::room_1_thermostat to a normal state

•  In the furnace control display window, use the mouse to slide the triangle to a value inside the alarm and warning
limits,

When the channel value enters the normal value range, the alarm channel disappears from the Valarm Viewer
window.

Exiting Valarm Viewer

To exit the Valarm Viewer window completely, on the Alarm menu in the menu bar, select Exit.
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Adding Alarm Limits to the ASCII Database File
Before running Valarm, you first need to edit the original furnace.adb file (using a text editor) and add the keywords that
set the alarm and warning states for the channel. For detailed information on these keywords, see Chapter 2 Vgen in the
Vsystem Vaccess Concepts Guide and Chapter 1 Vgen Keywords in the Vsystem Vaccess Reference Guide.

For this tutorial, you will edit the $room_1_thermostat channel.

To edit a channel

In the furnace.adb file, use the arrow keys to move the cursor down to the line $room_1_thermostat.

1. Move the cursor to the end of the integer keyword and press ENTER.

2. Enter all of the lines below that appear in boldface type.

$room_1_thermostat

integer

alarm

la 10

lw 20

uw 100

ua 110

units "degrees"

label "thermostat setting room 1"

out

3. Now save the file and exit the editor.

Table 1 – Keywords for setting alarm and warning states

Keyword Description

alarm Enables warnings and alarms for the channel.

la
Sets the lower alarm limit on the channel. In this case, the channel enters a lower alarm state if it reaches
10 units or below.

lw
Sets the lower warning limit on the channel. In this case, the channel enters a lower warning state if it
reaches 20 units or below.

uw
Sets the upper warning limit on the channel. In this case, the channel enters an upper warning state if it
reaches 100 units or above.

ua
Sets the upper alarm limit on the channel. In this case, the channel enters an upper alarm state if it
reaches 110 units or above.

Running Down the Tutorial Database

You need to run down the tutorial database before using the vgen command to create a new Vsystem database. The
rundown procedure forces all application tools currently connected to the database to remove all claims to channel
ownership. The current channel values are saved, so that when the database is next accessed, it contains the values
last present before the rundown (unless you have generated the database again with the vgen command). If you
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use the command db_rundown -stop, the database is removed from memory, the database files are renamed to
backup files, and all programs connected to the database are exited.

To perform a rundown of the tutor database, enter the following command at your system prompt:

db_rundown -stop tutor

 

Generating the New Database

To convert the new furnace.adb database file into a new .idb intermediate database file, enter the following
command at your system prompt:

vgen furnace.adb furnace.idb

The following lines should appear:

[Processed 9 channels]

[Successful completion]

Now you need to map the new .idb file into memory with the following command:

db_map -emem=1000 furnace.idb tutor

Note The emem=1000 parameter increases your database emem (event memory). You will need this
increase in memory to run Valarm which, by default, creates an event message queue of 500 messages



Vsystem Tutorial

73

Using Vscript
This chapter provides an overview of Vscript and instructs you in creating a script file, compiling that script file, and
running a virtual processor to execute the file.

Vscript is a scripting facility that enables nonprogrammers to create utility functions and provides a networked
environment for building a control system. Vscript provides a simple method for performing such tasks as creating
simulations, writing control algorithms, and scheduling tasks.

The Vscript Components
The three primary components of Vscript are:

The Compiler

You can enter a list of commands, called a script, into Vscript via a standard text editor. The compiler translates this
script into an executable language for the virtual processor, which then executes the script. The compiler generates
helpful error messages and flags conditions or statements that it finds ambiguous. Thus, you have several ways of
expressing functionality with confidence that the compiler is interpreting the instructions correctly.

The Virtual Processor

The virtual processor executes the compiled script. Because the virtual processor is stack-based, most Vscript
instructions take operands off the stack and leave results on the stack. The instructions are intended to provide all of
the functionality required to write scripts that can easily access Vsystem real-time database channels. Scripts can be
repetitive, conditional, or both.

Vscript creates an environment that enables multiple servers, each on a different node, to run multiple virtual
processors. A virtual processor runs only one script at a time; however, one server can run multiple processors
simultaneously, thus permitting several scripts to execute at the same time.

The Command Interface

The client/server based command interface controls the virtual processor, monitoring and controlling all actions
and communicating back and forth with the virtual processor during user command execution. The client is the user
interface program that accepts commands from the user and sends them for execution to the appropriate server. The
server provides and controls the resources necessary for script execution.

Creating a Vscript File for the Furnace Display
This section tells you how to create a text file, hereafter referred to as a sequence file, that defines a sequence for Vscript.
You will also learn how to compile this file so that a virtual processor can read it.

Writing a Sequence File

Vscript includes a compiler in which the output is saved to a file that is loaded later into the virtual processor. To
create the sequence file, room1.seq, that will be used by the compiler, use a text editor such as Notepad.

To create a sequence file

Open a text editor file, name the file "room1.seq", then enter the #load compiler directive and the tutor:: database
name, as shown below:

#load tutor::
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The primary function of compiler directives is to instruct the compiler and make writing scripts more convenient. Full
channel names are often quite long; the #load directive simplifies entering the code and speeds up compilation
by preloading the channels you are interested in and adding and defining a shorter name for each channel. Once
loaded, a channel can be referenced by either its full name (<database>::<channel name>) or by the short name
defined by the #load directive.

1. Enter the following label:

top:

Labels are the targets for goto expressions. Any word in the input file that is terminated with a single colon is
added to the list of labels and is a valid target for a goto statement. For example:

top:

.

.

.

goto top

(Do not add the above example to your room1.seq file--this is simply an example of a goto statement.)

2. Enter a wait until command, as shown here:

wait until (furnace_status = "AVAILABLE")

Whereas directives are instructions to the compiler, commands are translated into instructions for the
virtual processor. The wait until command causes the script to pause until a logical state is true or until
an optional timeout expires. In this case, the wait until command causes the script to pause until the
furnace_status channel is AVAILABLE.

3. Enter a while command, as shown here:

while (furnace_status = "AVAILABLE")

When the while command is used, the command loop executes as long as the condition is true. In this case,
the loop executes as long as the value of the furnace_status channel is AVAILABLE.

4. Enter the following structured if command:

if room_1_temp < room_1_thermostat

room_1_damper = "open"

room_1_temp = room_1_temp + 1.073

furnace_control = "on"

else

room_1_damper = "closed"

 
if room_2_damper = "closed"

furnace_control = "off"

end

end

wait 1.0

end
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The if command provides conditional execution. The above command structure executes if the value of
room_1_temp is less than the value of room_1_thermostat. If this condition is true, the Room 1 damper is
opened, the temperature is raised in 1.073-degree increments, and the furnace_control channel is turned
on.

If the value of room_1_temp is equal to or greater than the value of room_1_thermostat, the
room_1_damper is closed. If the room_2_damper is also closed, the furnace_control channel is
turned off.

The wait command instructs the script to wait one second between temperature increments.

5. Enter a goto expression and its target, as shown here:

goto top

top is the target of the goto expression (note the absence of a colon between the expression and its target).

6. The completed file should look like this:

#load tutor::

top:

wait until (furnace_status = "AVAILABLE")

while (furnace_status = "AVAILABLE")

if room_1_temp < room_1_thermostat

room_1_damper = "open"

room_1_temp = room_1_temp + 1.073

furnace_control = "on"

else

room_1_damper = "closed"

if room_2_damper = "closed"

furnace_control = "off"

end

end

wait 1.0

end

goto top

After you have finished entering the room1.seq file, save it as a text file according to the operations for your
particular editor.

You can find a copy of the room1.seq file in the Vsystem Vista/vsys/examples/script subdirectory.

Compiling the .seq File to a .vexe File

To compile a script file, you must provide the compile qualifier with the vscript command. At the system prompt,
enter the following command to translate the script file, room1.seq, into a file the virtual processor can use:

vscript /compile <.seq file pathname> room1.seq

where <.seq file pathname> is the complete directory specification for the location of the room1.seq file.

The following text should appear:
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No errors.

18 lines successfully compiled.

The compiler creates these two files: room1.log and room1.vexe.

The log file This file contains the formatted source code, intermixed with messages, warnings, and errors from the
compiler. The source code is formatted to show nested flow control, which simplifies debugging.

The Vscript executable code is in room1.vexe. This ASCII file contains the Vscript executable instructions that the
virtual processor can execute. This file is not generated if the compiler detects errors.

Executing the Script

To execute the instructions of the .vexe file, you must first create a virtual processor. Use the file qualifier with the
vscript command to create the virtual processor. The virtual processor can have the same name as the .vexe file,
but we recommend that you use a different name. A virtual processor name can have up to 15 characters. If you do
not name the virtual processor, Vscript names it for you.

The virtual processor name for the room1.vexe file is room1_temp. Enter the command in the following format:

vscript -file=<.vexe file pathname> <processor name>

where <.vexe file pathname> is the complete directory specification for the location of the .vexe file, and
<processor name> is the name of the virtual processor, in this instance, room1_temp. For example:

  WIN    vscript -file=c:\vista\vsys\examples\script\room1.vexe room1_temp
  VMS    vscript /file=vsys_root:[examples.script]room1.vexe room1_temp
 LINUX   vscript -file=/vsys/examples/script/room1.vexe room1_temp

Viewing Script Execution in Vdraw

Although Vscript does not require the presence of Vdraw, this portion of the tutorial uses both. At your system
prompt, enter:

vdraw /active furnace_tutor

to open the active furnace_tutor control display window.

The furnace control display window appears in the active mode. If the value of the Room 1 Temperature Meter
control tool is less than the value of the Room 1 Thermostat Meter control tool, the Room 1 Temperature Meter
control tool increments in one-second intervals by the value assigned to it in Vscript, 1.073, until it matches the
number of units for the Room 1 Thermostat Meter control tool, as shown in Figure 32.

Figure32 - Meters showing scripted behavior
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Furnace Status

Set the Furnace Status to Available.

Room 1 Thermostat

Adjust the thermostat to a warmer temperature.

Note If the value of the Room 1 Temperature Meter control tool is equal to or greater than the value
of the Room 1 Thermostat Meter control tool when you open the furnace control display window, use
the mouse to move the arrow of the Room 1 Temperature Meter control tool to the right to decrease its
value. When you release the mouse button, the arrow on the Room 1 Temperature Meter control tool
begins incrementing.
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 The room1_temp script also specifies that when the temperature value is equal to or greater than the thermostat
value, the Room 1 Damper control tool automatically closes. If the Room 2 Damper control tool is also closed, the
furnace control channel turns off automatically. This section of the script reads as follows:

room_1_damper = "closed"

if room_2_damper = "closed"

furnace_control = "off"

end

In the active furnace control display window, if the Furnace Control button reads "Off," use the mouse to click the
button so that it reads "On." If the Room 2 Damper control button reads "Closed," click that button so that it reads
"Open."

Use the mouse to move the arrow of the Room 1 Temperature Meter control tool to the right to decrease its value.
When you release the mouse button, the arrow on the Room 1 Temperature Meter control tool begins incrementing
until it matches the value of the Room 1 Thermostat Meter control tool. When the values match, the Room 1 Damper
control button automatically changes to "Closed."

Use the mouse to click on the Room 2 Damper control button so that it reads "Closed." When both Damper control
tools are closed, the Furnace Control button automatically changes to "Off".

Controlling the Vdraw Control Display Window from Vscript

Vscript provides a command interface that permits you greater control of scripts. (Refer to the Vsystem Vscript User's
Guide for more information on the command interface.) For this tutorial, you use the Vscript commands stop to halt
the script action and start to restart the script.

The last command you entered in the system window in which you are running Vscript should have been similar to
the following:

  WIN   vscript -file=c:\vista\vsys\examples\script\room1.vexe room1_temp
  VMS   vscript /file=vsys_root:[examples.script]room1.vexe room1_temp
 LINUX  vscript -file=/vsys/examples/script/room1.vexe room1_tempIf it is not, execute the
above example.

To start the command mode, enter the vscript command at your system prompt. The default node name appears,
to signal that you are in command mode. For example:

DEMING::>

where DEMING is your default node name for the following examples.

Move the mouse pointer back to the active Vdraw image. Use the mouse to move the arrow of the Room 1
Temperature Meter control tool to a low value, such as 10, to give yourself enough time to return to the Vscript
window and enter the stop command.

When you release the mouse button, the arrow on the Temperature Meter control tool begins moving.

Click on the command window to select it. At the node prompt, enter the list command to view the active scripts. 
Then enter the stop command and the name of the script you want to stop, as shown here:

C:\vsys43\examples\script>vscript

Connected to Vserver

DEMING::> list
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DEMING::> VProcessor      Owner                            User Name

DEMING::> ROOM1_TEMP                                       SYSTEM

DEMING::> End of List

DEMING::> stop room1_temp

When you press ENTER, the stop command executes and Vscript attaches to the rooom1_temp script and prints a
message to confirm the command execution, as shown here:

DEMING::ROOM1_TEMP> executed STOP command

DEMING::ROOM1_TEMP> No more instructions

The arrow on the Temperature Meter control tool stops.

To restart the arrow, enter the start command at the node prompt, as shown here:

DEMING::ROOM1_TEMP> start

DEMING::ROOM1_TEMP> executed GO command

When you press ENTER, the start command executes and Vscript prints a message to confirm the command
execution. The arrow on the Temperature Meter control tool begins moving again.

Return to the system prompt by entering the exit command at the node prompt, as shown here:

DEMING::ROOM1_TEMP> exit

When you press ENTER, the system prompt reappears.

You have completed the Vscript section of the tutorial. Deactivate the Vdraw furnace control display window and exit
Vdraw via the Exit button in the Vdraw Toolbox. You do not need to save the Vdraw window prior to exiting.

Note If you plan to continue on to the next chapter, Using Vlogger , leave the Vdraw furnace control
display window open and active and reenter the start command instead of the exit command.
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Using Vlogger
This chapter introduces Vlogger and instructs you in how to use the Vlogger graphical interface (Vlogwin) to create a
logger and to view and modify the logger settings.

Vlogger acquires data from the Vsystem database and logs (archives) it to disk or tape files, called archive files. You can
configure Vlogger to archive data under a variety of circumstances:

•  At specified time intervals.
•  When channel values change.
•  When a trigger channel changes.

You can temporarily stop archiving and add or delete channels on the list of channels archived as the system is running. In
a complex system, in which different channels may need to be archived at different rates, Vlogger enables multiple logging
processes to run on each node.

In addition, Vlogger provides you with utilities (both command-line interface and graphical interface) that enable you to
copy an existing archive, combine several archives, copy the time range of data in an existing archive, rename an archive,
delete existing archives, and replay previously archived files back into a database.

The command-line interface utilities include Copy, Delete, Merge, Range, Rename, Replay, and Table, as well as the SQL-
like command you can use for quick and easy access to data in archive files. The graphical interface utility, Varchive,
provides you with an easy-to-use way of running most of the command-line interface utilities through the Varchive
window.

The Playback utility enables you to "play back" into a Vaccess database all or a portion of an archived file. For example,
if the logger has recorded the ramping of a furnace to a certain temperature, you can play this archive file back into the
database to perform exactly the same ramping operation.

Vtrend is a history and trending application for viewing the archived data generated by Vlogger. Using Vtrend, you can
select the starting and ending time for viewing data in an archived file. Vtrend permits you to visualize archived data
graphically (with plots) and to analyze the selected archive files quickly and easily. You can view any number of archived
channels in one session.

Using Vlogwin
Once you have defined the tutor database, you can start archiving its data with the Vlogger graphical interface, Vlogwin.
To open Vlogger, enter the following command at your system prompt:

vlog -win

After you issue the vlog -win command, the Vlog window appears, as shown below.

Figure33 - Vlog window
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Creating a Logger

New

On the toolbar, click the New button. or, in the Logger menu in the menu bar, select New.

List Box
The list box in the Vlog window displays information about loggers. The options you select on the Options
menu in the menu bar determine which columns in the list box display information. Table 2 describes the
information you will find beneath each heading in the list box.
Table 2 – Information displayed in Vlogger under column headings

Heading Information Displayed

Name The names of existing loggers.

User The name of the user who is attached to (and controlling) the logger.

Attached Whether the logger is attached.

State The state of the logger: S for stopped and R for running.

Scan The number of times the data have been scanned.

Process The process number.
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The New-Properties dialog appears, as shown in Figure 34, in which you can specify properties for the new logger.
Figure34 - New - Properties dialog

Name
In the Name field, enter Furnace for the name of the logger.

Type Tab
Use the options on the Type tab to specify the type of archiving you want to set up for the new logger.

Archiving Mode
From the following options, select Time to specify the archiving mode.

Time This standard archiving mode archives data periodically. Vlogger archives the values of all of the
selected channels to an output file at the specified time interval, see Time Rate

Event This archiving mode archives the value of a channel only when it undergoes a significant change in the
database.

Trigger This archiving mode uses a binary channel in the database as a trigger for archiving the channel
values. When you select this archiving mode, you must also select a binary channel, so that when this
channel enters its binary one (B1) state, Vlogger archives the values of all of the selected channels to
an output file. The binary channel then changes to its binary zero (B0) state, and the logger waits for
the state of the trigger channel to become B1 again before archiving values.
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Time Rate
If you have Time selected for Archiving Mode , you need to specify the time interval, in seconds, between
each logging pass. (You can also specify fractional time in this field.) Here, enter 1.0.

Note You can change the Time Rate entered here at any time during the logger operation.

Archive Tab

Archive tab
Select the Archive tab to specify the output archive file and how you want to run the output.
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Edit field
To specify the output archive file for a logger
•  In the text box, enter the archive file name and path, then click Apply next to the field.
-or-
•  Use the Browse button to find the file you want to archive.
Here, enter <pathname>room_1_temp.varc (where <pathname> is the complete directory specification
for the location of the .varc file).

Apply button
Hit Apply when the filename has been entered

Archive Type
From the following options, select Normal to specify the type of archive you are creating:
 

Normal This option creates a regular logger instead of a shared or sequential logger.

Shared This option creates a logger that allows other processes to access it while it is open. Data in
a shared archive becomes readable with the latency specified, or after you flush the logger.

Sequential
By default, the logger is written into at least two files, one header file and one or more data
files. Select this option if you want the logger to be written into a single file, which allows it
to be written to a single device, such as a tape.

Replace Current Archive
Click this checkbox to cause the new output archive file for the logger overwrite the existing output archive
file, if any. If this option is unchecked, the existing output archive file is not overwritten, and a new archive
file is begun.
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Channels Tab

Channels Tab
Select the Channels tab to specify which channels the logger is to archive.

Channel Name
To specify which channel to archive, enter the channel name, tutor::*, in the field.  An asterisk is allowed
for a wildcard or channels can be added individually.

Apply
click the Apply button next to the field. The channel name displays in the list box below the field.

Choose
You can also use the Choose button to open the Archived Channels window, in which you can specify which
channels to archive.
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OK or Apply
When you have finished specifying the information in the New-Properties dialog and are ready to execute
your changes, click either OK or Apply . If you click OK, the dialog closes; if you click Apply, the dialog
remains open, allowing you to make further changes.

Operating Loggers

In the Vlog window, you can perform various functions on your selected logger by choosing options or buttons. This
section describes how to perform these functions. Note that before using the following options to operate a logger,
you must first select the logger.

Go

To start or continue archiving with the selected logger, on the toolbar, click the Go button or on the Logger
menu, select Start.
Once you start a logger, after a 0- to 10-second delay, the State column in the list box changes to R ,
indicating that the logger is running.
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Archiving Data From the Furnace Control Display Window

Although Vlogger does not require the presence of Vdraw, this portion of the tutorial uses both. At your system
prompt, enter:

vdraw /active furnace_tutor

The furnace control display window appears in the active mode. To provide data for your logger to archive, move the
needle of the Temperature Meter control tool back and forth with your mouse. Change the temperature to a value
below that of the thermostat and allow the Temperature Meter control tool to increment to the same value as the
thermostat.

Stop

To stop the selected logger process, click the Stop button or on the Logger menu, select Stop.
The archiving process stops.

Abort

To terminate the selected logger process, forcing it to exit, click the Abort button or on the Logger menu,
select Abort.
All output buffers are flushed to disk and all output files are closed.

Modify

To change the various parameters of the selected logger, click the Modify button or on the Logger menu,
select Modify.
The Modify-Properties dialog appears, in which you can make changes.
When you modify a logger, you remain attached to it, preventing others from controlling it. Therefore, after
you work in the Modify-Properties dialog for a few minutes, a message appears reminding you that you are
attached to the selected logger.

Viewing Archived Files with Vtrend
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You can use Vtrend to view graphically the history and trending information of an archive file. Before you can do so for the
tutorial, however, you need to abort the logger whose archive you want to view (select the logger and then click Abort in
the toolbar).

Note The logger can be set up as "shareable" so that it is running at the same time that Vtrend is viewing the
data. For this tutorial, however, the logger is set up as "normal," and so must be aborted before Vtrend is run.

 

To access Vtrend, enter the following command at your system prompt:

vtrend

The Vtrend window appears, as shown below.

Open

 To open an archive file in Vtrend, on the toolbar, click the Open button, or on the File menu, select Open
Archive.

An Open window appears, in which you can find and open the file you archived, room_1_temp.varc. When you open the
archive file, the Archive Properties dialog appears. The file you selected will appear in the Archive(s) list box of the Archive
Properties dialog.
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Figure35 - Archive Properties dialog

OK
Click OK at the bottom of the dialog. The Reading Archive File window appears, as shown in Figure 36, listing the
file you have selected.

Figure36 - Reading Archive File window
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Close
Click Close to continue on and view the data.

Figure37 - Vtrend
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The Vtrend window appears, as shown in Figure 37, showing graphical plot of the chosen channels. This window shows a
graphical plot of the channels as archived by the logger.

When you place your mouse pointer within the graph, cross hairs appear, which you can use to determine the value and
time represented by any particular point on the graph. Move the mouse pointer around the graph and note the changes in
the Value and Time columns in the list box below the graph.

You have now completed the Vsystem Tutorial. You may close Vtrend by selecting Exit on the File menu in the menu bar,
and close Vlog by selecting Exit on the Logger menu in the menu bar.
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Glossary of Terms
Active window A drawing window that links to the real-time database and displays "live" data.

Archive A group of one or more binary files created by Vlogger.

Binary channel A two-state channel; for example, a channel that is either "on" or "off."

Channel A fundamental structural unit of the Vsystem database; the communication path between
Vaccess and a hardware device or other software. A channel is an element within the database
that is used to store information about a piece of hardware or to represent other information.
A channel includes a name, a value, a type, and other fields that describe the behavior or the
channel.

Channel file A text file containing a list of channels.

Click A mouse term that refers to pressing and then immediately releasing the mouse button.

Client A user interface program that accepts commands from the user and sends them to the
appropriate server for execution.

Command interface The interface that controls and communicates with the virtual processor.

Command line A computer's operating system prompt.

Commands Instructions for the virtual processor.

Compiler A program that translates script into an executable language for the virtual processor.

Compiler directives Instructions for the compiler.

Control channel An output channel that attaches to and controls the hardware.

Control display
window

The window in Vdraw that contains the control tools (such as buttons, meters, etc.) with which
you can manipulate the control system.

Control tool buttons Tool buttons in the Vdraw Toolbox that you use to create control objects (such as meters, bars,
etc.) in a control display window.

Control tools Tools (such as meters, bars, etc.) that dynamically connect the Vdraw control display window to
the Vsystem database; they enable you to monitor and control equipment from any workstation
on the network.

Controllable An option you can select when creating control tools that allows you to control them with a
mouse from an active control display window.

Database A group of channels.

Db_map A program that uses the intermediate file generated by Vgen to create shared memory regions
for the database, so that other programs can access the database.

Db_rundown A Vsystem utility that notifies programs to disconnect from a database and optionally removes
the database.

Db_view A Vsystem utility used to view and modify a database.

Dollar ($) character A symbol that signals the beginning of a channel definition.

Double-click A mouse term that refers to clicking the mouse button twice in quick succession.

Double-precision
floating-point
number

A floating-point number with twice the usual number of significant digits.

Drag A mouse term that refers to pressing the mouse button while at the same time moving the
mouse.
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Drawing tool A tool in the Vdraw Toolbox that you use to create objects.

Drawing window A window in which you can graphically create and modify a control display window.

Emem The shared memory region where events are stored.

Event The notification given to other programs when a field in a channel has changed.

Field A part of a channel; each field describes an item in a channel.

Floating-point
number

A number in which the decimal point can be in any position; for example, the computer may
record 6.20, 240.280, or 0.00003 in the same field, depending on the circumstances. If a field is
not defined as a floating-point number field, that field can only accept numbers with the decimal
point in a particular place, such as 0.3, 0.8, etc.

Hexadecimal number A number written in base-16; a shorthand way to represent binary numbers.

Integer channel A channel whose values consist of whole numbers.

Keywords Words that have special meaning in Vsystem.

La Lower Alarm

Line weight The thickness of a line.

List box An area in a dialog box or a window in which a list of items is displayed.

Lower alarm limit A value defined in the database for numeric channels; if the value of a channel falls below this
limit, the database will issue a lower alarm event.

Lower alarm warning A value defined in the database for numeric channels; if the value of a channel falls below this
limit, the database will issue a lower alarm warning.

Lw Lower Warning

Macro A user-defined sequence of frequently used instructions. By converting these instructions to a
macro, this sequence is reduced to a brief series of keystrokes.

Match alarm An alarm value that exactly matches a channel value; for example, if the alarm value is 60.012, the
system will only record an alarm event if the channel reaches 60.012.

Mouse pointer A mouse term referring to the arrow that appears on the computer screen and moves about the
screen as the mouse is moved.

Movement resolution The numeric amount that a meter, dial, or bar will increment as it changes values (e.g., one-tenth
of a unit).

Nodes Computers that are part of a networked system.

Object A "thing" created in a control display window, such as a furnace or a control button.

Playback A Vlogger utility that allows you to "play" an archived file back into a Vaccess database. For
example, if you have recorded a particular action that you want to occur again, you can insert
that action back into the database.

Pointer tool The tool in the Vdraw Toolbox used to highlight and then manipulate objects in the Vdraw
control display windows.

Pop-up menu A menu that appears on the screen when a particular action is performed, such as clicking the
right mouse button or creating an object in a drawing window.

Press A term that refers to pushing down a mouse button or a keyboard key.

Push button A button that places a channel in a true binary state as long as the mouse button is depressed;
once the mouse button is released, the channel returns to its false binary state.

Real channel A channel whose values consist of real numbers.
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Real-time database A database that reflects data changes as they occur in the system.

Running down a
database

A procedure that forces all application tools currently connected to the database to exit and
removes all claims to channel ownership.

Select A mouse term that refers to clicking the mouse button while the mouse pointer is positioned on
an object on the computer screen.

Selection rectangle A rectangle that can be placed around an object or objects to select them for editing.

Sequence file A file that defines a sequence of actions in Vscript.

String A sequence of characters that are treated as a single data item.

Syntax The rules that specify the order in which the characters of a computer language may be strung
together to create complete statements.

Field An area in a dialog box in which you can type text.

Toggle button A button that switches a channel between its two binary states (such as "Off" and "On").

Toolbox The window in Vdraw that contains the tools with which you can create and manipulate the
Vdraw screens.

Ua Upper alarm

Upper alarm limit A value defined in the database for numeric channels; if the value of a channel rises above this
limit, the database will issue an upper alarm event.

Upper alarm warning A value defined in the database for numeric channels; if the value of a channel rises above this
limit, the database will issue an upper alarm warning.

User A person who is attached to and controlling a logger.

Utility A program that assists in the operation of one of Vsystem's components.

Uw Upper warning

Vaccess A user-extensible, real-time database and library of access routines.

Valarm An alarm display program that monitors alarms and warnings within the database.

Valarm Daemon A Valarm utility that logs and prints alarm events as they are entered, acknowledged, and
enabled or disabled.

Valarm Historian A Valarm window that displays the alarm history archives; a "snap shot" of an alarm archive file.

Valarm Viewer A Valarm window you can use to view, acknowledge, and print active alarms; to add and delete
monitored alarm channels; and to enable and disable alarms.

Varchive Vlogger's graphical interface utility.

Vdraw A graphically oriented toolbox used to create and run control displays.

Vgen Vsystem's database-generating utility.

Viewer The Valarm Viewer.

Virtual processor A processor that executes a compiled script.

Vlogger The Vsystem program that archives data from the Vsystem database.

Vlogwin The Vlogger graphical interface.

Vscript The Vsystem program that provides a connection between the input hardware and the Vsystem
database.

Vtrend Vlogger's history and trending program.
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